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Introduction

Local and state social services have statutory responsibility to provide for the
safety, permanency and well being of children and families receiving services.
Social services are provided in a way that improves functioning for children and
families in the community.

Social services staff must be able to assess the outcomes to children and families
from the services provided, and report those outcomes to state and federal
officials. In order to adequately assess the quality of services provided, and the
efficacy of those services, local social service agencies must be able to analyze
data about children and families, and make judgments and recommendations for
improving services based on that analysis.

SSIS Data Analysis and Charting provides two processes related to child welfare
for analyzing SSIS data in order to make decisions based upon that data. One
process is initiated when social workers need to analyze their efforts related to
federal outcome indicators to assess their progress toward outcomes defined by
the federal government. Another process is initiated when social workers need to
evaluate their state child welfare system activity to assess county social system
operations.

There are two slightly different versions of the application. One runs against
county databases; another runs against the state repository database.
Department of Human Services staff pull reports from the state repository
database. This information is updated on the CountyLink>DHS Systems & IT
Updates>SSIS>Outcome Charting>Federal Indicators or State Indicators web
page twice yearly.

The primary objective of SSIS Analysis and Charting is to allow county and state
personnel to visually analyze data and view statistical measures from data in

SSIS databases to evaluate outcome indicators.

The secondary objective is to make this capability easy to understand and to use.
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Overview of Federal Outcome Data

Federal regulations by the Administration for Children and Families (ACF) to
derive and set forth the requirements for the Child and Family Services Review
(CFSR) permanency composite measures used during CFSR reviews. This
includes establishing national standards for certain statewide indicators that will
be used, in part, to determine a state’s substantial conformity under Titles IV-B
and IV-E of the Social Security Act.

The national standards are based on information that is reported by states to the
Detailed Case Data Component of the National Child Abuse and Neglect Data
System (NCANDS) and the Adoption and Foster Care Analysis and Reporting
System (AFCARS).

The data shown below established the Federal Standards:

e Recurrence of maltreatment (recent NCANDS data)

e Incidence of child abuse and/or neglect in foster care (NCANDS data)

e Foster Care re-entries, length of time to achieve reunification, length of time
to achieve adoption, and stability of foster care placement (AFCARS data).

OHint: You can chart your county’s data and compare with the national standards
and/or select SSIS web charts and compare with state data.

BN

\
)

=" Job aids: The following job aids are available on the SSIS website:
e Some Requirements of the Adoption and Safe Families Act of 1997
e AFCARS — SSIS Repository Cross Reference

o AFCARS Foster Care Data Elements.
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Accessing Analysis and Charting

Analysis and Charting is a separate executable, e.g., a separate piece of the SSIS
application from SSIS Worker/Fiscal and SSIS Administration. Even though it is a
separate executable, it can be accessed from the SSIS Worker application. A
worker must have an assigned security function in SSIS Administration before
Analysis and Charting access is enabled.

This security function is Access Charting and Analysis.

SSIS Administration Available Functions
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List functions for rale | <<Show all functionss » ﬂ
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terge Professional Collateral - Enter Another Personz Time
Wiew CP reports tanage Contract

< Bemave

Wiew ztate workgroups tdanage Payment

Add '&‘" 3y Manage Staff
Feset Errors

¢ Remove Al | Yiew Cnty Detail
_I View State Detail

iElrl

To assign Access Charting and Analysis to a worker’s assigned functions:

1. Access SSIS Admin icon on a worker’s desktop.

2. Select Lists from the Application toolbar.

3. Select Role List.

4. Select the appropriate role, e.g., Supervisor, Planner/Evaluator,
QA/Auditor/Federal Reviewer, or System Administrator in the list.
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Click Editor button or double-click on the role to view Role information.
Select Access Charting and Analysis in the Available Functions field.
Click Add button.

Click OK.

. Close Role List screen.

10. Close SSIS Administration screen.

© P N o

To access SSIS Analysis and Charting from your desktop:

7y

1. From SSIS Worker/Fiscal, select the Tools menu.
2. Select SSIS Analysis and Charting.
3. The SSIS Analysis and Charting home page displays.

SSIS Analysis and Charting Home Page

¥4 SSIS Analysis and Charting 5.5.0.109

File Toaols Help

Home | Charting Features | Federal Indicators Round 1 | Federal Indicators Round 2 | State Indicators | Data Descriptions

Federal elcome to the SSIS Analysis and Charting tool.
Indicators

round 1

This tool provides descriptive statistics about S3IS data in both graphic and numerics to help you better visualize and analyze

Eederal that data.
indicators

rounct 2

Stele. Charts
indicatars

Graphic representation of data includes bar, line, and pie charts.

dllla M\

Reports

=xl
()

Sl
eh
Chars

=

Wiewr or print reports containing a chart, its frequency distribution, and the raw data behind a chart ‘

MH DHS Social Senices Information System

The SSIS Analysis and Charting home page includes Charting Features, Federal
and State Indicator Overviews, and Data Descriptions. The home page is set up
similar to an internet web page.
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SSIS Analysis and Charting Home Help Menu

The Home Help menu at the top of the home page provides information on
Charting Features, Federal Indicators Round 1, Federal Indicators Round 2, State
Indicators and Data Descriptions.

SSIS Analysis and Charting Home Help Menu

Homie | Charting Features | Federal Indicators Round 1 | Federal Indicatars Round 2 | State Indicators | Data Descrptions

Charting Features

Charting Features provides an explanation of the available features in Analysis
and Charting.

Charting Features

Horme | Chatting Features | Federal Indicators Bound 1 | Federal Indicators Round 2 | State Indicators | Data Descriptions

Charting Features

Chart Styles

Chart styles include Line charts, Bar charts, and Pie charts. Each performance indicator displays with the chart style most suited to the data being represented. You may
select a different chart style if you wish.

Data Selection
Data: To access enhanced grid features (such as grouping and sorting), right click on the data. The enhanced grid menu will display.

Categories: Selecting a category organizes data by an attribute such as gender or race. For example, you are charting placement related measures and want to compare
the number of boys vs. girls in placement. Select the category of "gender” to illustrate such data.

Filters: If you want only specific data, choose a category and a filker. This provides sub-groups such as gender and age group. For example, you are charting placement
related measures and want & chart representing children under age eight. Select the category of "gender” and 2 filter of "age” to compile the desired chart.

Date Range: Sorne measures are for sis-month or twebe month periods. In these cases, you can select a "from date” and the "to date” automatically displays. To plot a
different periad, change the "from date.”

Navigation
Data/Chart: Toggle between viewing a chart and raw deta,
Refresh: Use this feature to refresh a chart after selecting new cateqories o filters.
Report: Ater selecting, a report disnlays in @ pop-up preview windaw. The report includes hoth & chart and raw data.
Copy: Use this feature to copy and paste the chart into a document, report, Power Pairt, or emall message.

Chart Zooming: Line and bar charts have a zoam feature that allows you to enlarge a selected area of a chart. Hold the left mouse button, drag right and down to bracket
the area to be zoomed. Restore the zoom by holding the left mouse button down and dragaing left and upward.

Chart Scrolling: Line and bar charts have a scroll feature that allows scrolling a chart to a particular area. Hold the right mouse button down and drag the chart.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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To view Charting Features:

Y Select the Charting Features link.

The Charting Features link includes navigation tips and definitions of the
following features:
e Chart Styles
e Data Selection

- Data
Categories
Filters

- Date Range
e Navigation
Data/Chart
Refresh
Report
- Copy
Chart Zooming
Chart Scrolling
e Display Options
Chart Options
Customize Colors
Values
Legend
2D/3D.

~— Job Aid: A Charting Features job aid is available on the SSIS website.

Federal Indicators Round 1

The Round 1 Federal Indicators Overview lists all of the previous Federal
Measures used in Charting and Analysis since SSIS Version 3.7, their definitions,
and any important determining factors used to report that information from
SSIS. The major categories are:

e Recurrence of Maltreatment

e Incidence of child abuse and/or neglect in foster care

e Permanency

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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e Length of time to achieve reunification

e Foster care re-entries

e Length of time to achieve adoption

e Stability of foster care placements

e Age-Appropriate Placements for Children.

Round 1 Federal Indicators Overview

Hatme | Charting Features | Federal Indicators RBound 1 | Federal Indicators Round 2 | State ndicators | Data Descriptions

Round 1 Federal Indicators Overview

Federal regulations set forth the requirements for the child and family senice reviews, including the establishment of national standards far certain statewide indicators that
will be used, in part, to determine a state's substantial confarmity under Title 1v-B and IV-E of the Social Security Act.

The national standards are bazed on information that iz reported by states to the Detailed Case Data Component of the National Child Abuse and Meglect Data Systems
(NCANDS) and the Adoption and Foster Care Analysis and Reporting System [AFCARS).

Recurrence of Maltreatment

Measure 1.1: Of all children who were victims of substantiated or indicated child abuse andfor neqlect during the first six months of the period under review, B.1% or fewer
children had another substantiated of indicated repar within six manths. (NCANDS data for calendar vears 1997 and 1995),

Incicence of child abuse andlor neglect in foster care

Measure 2.1 OF all children in foster care during the period under review, the percentage of children who were the subject of substantiated or indicated maltreatment by 3
foster parent or facility staffis 0.57% or less. (NCANDS data for January - Septernber of 1997 and 1998; and AFCARS data for January - September of 1937 and 1398),

Note: The database query for this measure searches all children in placement 90 days before the reporting period and during the reparting period and then loaks for facility
maltreatment reports that were substantiated during the reporting period in which those children are victims. This is intended ta include cases when a maltreatment was
determined after the child was discharged fram care. When a placement is the only placement within "range” of the maltreatment, placement data (e.q. days ta substartiation)
will be provided. Howsver, because placements are not explicitly linked to particular facility maltreatment recards, it is not certain the placement data will abways be comect, |t is
possible that a facility other than the foster care provider is the offending facility.

Permanency

A prirnary goal of child welfare serices is to find perrmanent hormes for children thraugh reunification wth their families, adoption, or legal quardianship. No national standards
are established for these five measures,

Measure 3.1: For all children who existed faster care during the reparting period what percentage left aither to reunification, adoption, or legal quardianship?

Measure 3.2: For children who exited foster care and were identified a5 having 2 diagnosed disability, what percentage left ether to reunification, adaption, or legal
guardianship,

Measure 3.3: For children who exited foster care and were alder than age 12 at the time of ther most recent entry into care, what percentage left either to reunification,
adoption, or legal guardianship?

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
Analysis and Charting Page 10 of 60



SSIS Training

To view the Round 1 Federal Indicators Overview:

)
@ Select Federal Indicators Round 1 link.

@ Job Aid: A Round 1 Federal Indicators Overview job aid is available on the SSIS
website.

Federal Indicators Round 2

The Round 2 Federal Indicators measure the Federal Safety Indicators in an
inverse form. For example, Round 1 Measure 1.1.: “Of all children who were
victims of substantiated or indicted child abuse and/or neglect during the
reporting period, what percentage had another substantiated or indicated report
within a six-month period?” is contrasted with the opposite view of Round 2
Measure RT1: Absence of Maltreatment Recurrence: “Of all children who were
victims of substantiated or indicated child abuse and/or neglect during the
reporting period, what percentage did NOT have another substantiated or
indicated report within a six-month period?”

The new Federal Permanency Indicators include greater detail to better describe
State performance.

Overview lists all the new composite Federal Measures, their definitions and any
important determining factors used to report that information from SSIS. The
major categories are:

e Child Safety

e Timeliness of Reunification

e Permanency of Reunification

e Timeliness of Adoptions

e Permanency for Children and Youth in Foster Care for Long Periods of
Time

e Placement Stability.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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Round 2 Federal Indicators Overview

Home | Charting Features | Federal Indicators Round 1| Federal Indicators Round 2 | State Indicators | Data Descriptions

Round 2 Federal Indicators Overview

Federal regulations set forth the requirements for the child and family service reviews, including the establishment of national standards for certain statewide indicators that
will be used, in part, to determine a state’s substantial conformity under Title V-8 and IV-E of the Social Security Act. The Round 2 indicatars were changed in 2006 by the
Children's Bureau of the Administration far Children and Families to reflect states’ most recent performance, and to reflect outcomes positively.

The national standards are based on infarmation that is reported by states to the Detailad Case Data Component of the National Child Abuse and Neglect Data Systems
(NCANDS) and the Adoption and Foster Care Analysis and Reporting System (AFCARS).

Child Safety

The safety indicatars have been reversed in round 2 measures so that a higher percentage eguals a higher performance level. The two indicatars are the percentage of victims
with substantiated maltreatrment who did not experience a recurrence of maltreatrent and the percentage of children in care who were not maltreated by a foster parent or
facility staff member.

Timeliness of Reunification

Round 2 measures for timeliness of reunification include 1) langitudingl assessment of timeliness of reunification facusing on an entry cohort and 2) measure of median length
of stay in foster care of children discharged to reunification.

Permanency of Reunification
Permanency of reunification iz the percentage of children who re-enter care in less than 12 months.
Timeliness of Adoptions

Timeliness of adaptions includes measures for. a longitudinal assessment of timeliness of adoptions and termination of parental rights for a cohort of children in foster care for
17 manths or langer; an assessment of the median length of stay in foster care for children exiting foster care to adoption; and a longitudinal assessment of the timeliness of
adoptions far a cohort of children who become legally free for adoption.

Permanency for Children and Youth in Foster Care for Long Periods of Time

Permanency far children in foster care for long periods of time is a completely new perfarmance measure. The first component includes children that were legally free for
adoption who were discharged to a permanent hame, and the percentage of children in faster care far 24 months ar longer who were discharged to a permanent home by the
end of the fizcal year. The second companent in this measure addresses children "growing up” in foster care: of children emancipated from faster care prior to age 18 or
reaching age 18 while in foster care, the percentage that were in care for 3 years or longer.

Placement Stability

Placement stabilty has an expanded focus on placement stability over time and excludes children in foster care for very short periods of time. The three components of
placement stability are: percertage of children in care for 8 days or longer but less than 12 manths with 2 or fewsr settings; percertage of children in care 12 to 24 months with
2 or fewer settings; and the percentage of children in care for 24 or more months with 2 or fewer placement settings.

b DHS Sacial Senices Information System

To view the Round 2 Federal Indicators Overview:

Select Federal Indicators Round 2 link.

Job Aid: A Round 2 Federal Indicators Overview job aid is available on the SSIS
website.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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State Indicators

SSIS Analysis & Charting also includes State of Minnesota Outcome Indicators.

The major categories include:
e State Safety Outcomes
e State Permanency Outcomes
e Child Welfare System Activity Indicators — Maltreatment
e Child Welfare System Activity Indicators — Placement
e Family Assessment Indicators.

These indicators are the result of collaboration between Minnesota Department
of Human Services staff and agency representatives who met to discuss and
establish priority Child Welfare outcomes.

State Indicators Overview

Home | Charting Features | Federal Indicators Round 1 | Federal Indicators Round 2 | State Indicators | Data Descriptions

State Indicators Overview

State indicators are grouped into four categories: State Safety Outcomes, State Permanency Outcomes, Child Welfare Systern Activity indicators, and
Family Assessment Indicators.

These indicators are the result of collaboration between Minnesota Department of Human Services staff and county representatives who met to discuss
and establish prionty child welfare outcomes.

The data source for the charts is your county SSI5 database. If you are interested in comparing county data with state data, return to the Home page
and select "S5I35 Web Charts.” The default chart for each measure is available. These chars will be updated for county users twice each year.

Note: Special data considerations are noted in some of the descriptions. Some measures involve data that is not yet available or reguired in 3512
{such as court actions), so the data for the measure may not be present in your county's SSIS data.

State Safety Outcomes

Measure MN1: Of all children who were victims of substantiated child abuse andfor neglect during the twelve months prior to the reporting period, what
percentage had another substantiated report within a twelve month period?

Measure MN2: Of all children whose families were receiving child protection services during the reporting period, what percentage had a subsequent
repart of maltreatment that was substantiated?

Note: Child Protection Services is defined as being a participant in either a Family Assessment or Investigative Child Protection Case Managerment
Workgroup. The guery looks at the percentage that had a subsequent report of maltreatment that was substantiated since the case management
workgroup was open.

Measure MNT: Of all children whose families were receiving child protection case management services during the reporting period, what percent had
a subseqguent report of maltreatment that received a Family Assessment?

State Permanency Qutcomes

Measure MN3: For all children who remain in placement, what percentage had a permanent foster care arder? Note: Since entering Court Actions into
S35IS are not reguired, this measure has a possibility of being inaccurate.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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To view the State Indicators Overview:

& Select the State Indicators link.

@ Job Aid: A State Indicators Overview job aid is available on the SSIS website.

\\\
‘i )
\ /

~— " Handout: Refer to Outcome Indicators Data Descriptions handout for
information to consider when reviewing Federal and State Outcomes. It is available on
the SSIS website.

@ Warning: Several state indicators may not be accurate if specific data is missing

in SSIS. These include the following:

e Measure MIN3: For all children who remain in placement, what percentage had a
permanent foster care order? Court Actions are a required entry in SSIS to ensure
this measure is accurate. For children under DHS guardianship, enter guardianship
in the Child Ward folder and TPR information in the Relationships folder located
under the client. Enter court actions establishing the permanent foster care order
under the Court Action folder at the Case level or under the individual clients” Court
Actions folder.

e Measure MIN5: For all children who had a termination of parental rights of any
living parent at anytime during the year, what percentage experienced finalized
adoption, declined adoption, or either reached the age of majority or were
emancipated? This measure requires the entry of inactive parent relationships,
finalized adoption and declined adoption information in SSIS to ensure accuracy.
Enter TPR information on the Child’s Relationships folder by Inactivating the birth
parents or adoptive parents relationships. For this measure, each living parent must
have a SPR, TPR, Consent to Adopt, or parent is deceased indicated on the
Relationships screen. Enter status of finalized adoption under the client’s Court
Actions folder.

e Measure MING6: For State Wards: How long have they been a State Ward, and what is
their placement setting? The worker must enter Guardianship information on the
Child Ward screen. The Placement setting is required on the
Placement/Location/Absence entry screen, e.g., Foster family home — relative, Pre-
adoptive home - non-relative, or Group home.

o  Welfare System Activity Indicator SSIS1: What was the percentage of child
maltreatment assessments initiated within 24, 48, 72, 96, 120, and over 120 hours of

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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acceptance of report? In this measure, acceptance of report is equivalent to the intake
disposition date.

Welfare System Activity Indicator SSIS 9: Average length of time between TPR and
placement of a child in a pre-adoptive home, for children currently in pre-adoptive
homes. This measure requires TPR information and the status of pre-adoptive
placement entry in SSIS in a timely fashion to ensure accuracy.

Data Descriptions

The Outcome Indicator Data Descriptions provides direction as to the Population
of children and the Target for what the Indicator is actually measuring with the
data for each of the Federal Round 1 and Round 2 and State Indicators.

Outcome Indicator Data Descriptions

Outcome Indicator Data Descriptions

These descriptions identify data, as viewed fram the SSIS Warker program, that affects Outcome Indicators. Each outcome has a population which is
the set of data being considered. Each indicator also has either a target or a classification. A target is a subset of the population. It is the subject of the
measure. A classification is a breakdown of the population. Unlike a target, each entity in the population is assigned a classification. Entities in the target
or classification are displayed in the Data grid in the Analysis program, while entities not in the target are not.

Federal Round 1 Measures

Reduce Recurrence of Child Abuse or Neglect

Measure 1.1: Of all children who were victims of substantiated or indicated child abuse andfor neglect during the first 6 months of the reporting period,
what percentage had another substantiated or indicated report within a 6 manth period?

Population - children who had an allegation where:

+ The allegation was determined within the start of the report period and the following six months AMND
e The maltreatment determination indicator is "Yes" AND
e The Report Status is "Assessment Complete” AND

# The reportis in a "Assessment” or "Case Management” warkgroup
Target — looks for a subsequent allegation in & subseguent report;
e That carries the same victim [D AND

« With a determination date within six months of the first allegation determination date in the first report AND
» The maltreatment determination indicatar is "Yes" AND

e The Report Status is "Assessment Complete” AND
e The report is in an "Assessment” or "Case Management” workgroup

Reduce the Incidence of Child Abuse andior Neglect in Foster Care

Measure 2.1: Of all children who were in foster care during the reporting period, what percentage was the subject of substantiated or indicated
maltreatment by a foster parent or facility staff?

Note: This measure does not have a population and target, rather it compares two groups of children. Children included in group 2 may not have a

placerent during the same time period because they may have been placed by a different agency, or they may have been in placement previously but
were no longer in care when the maltreatment was determined.

To view the Outcome Indicator Data Descriptions:

63 Select the Data Descriptions link.

Social Services Information System (SSIS) Version 5.2 D
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SSIS Analysis and Charting Application Toolbar

Again, the primary objective of SSIS Analysis and Charting is to provide county,
tribal and state personnel the ability to visually analyze data and view statistical
measures from data in SSIS databases to evaluate outcome indicators.

The secondary objective is to make this capability easy to understand and use.

The Application toolbar allows the worker to customize some of the visual
components of the Analysis and Charting.

Application Toolbar

‘File Tools  Help

File Menu

The first option on the application toolbar is the File menu.

File Menu

IaH Help

Log Off
Oplions

ik

To view the File menu:

D) Select File menu.

The File menu contains:

e LogOn
e Log Off
e Options
e Exit.
Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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As with SSIS Worker/Fiscal, it is not necessary for workers to close the
application entirely when not in use for short durations of time. Select Log Off to
disable SSIS Analysis and Charting. The Federal indicators round 1, Federal
indicators round 2, State indicators and SSIS Web Charts are grayed out.

SSIS Analysis and Charting Disabled

To Log Off of SSIS Analysis and Charting:

@
1. Select File menu.
2. Select Log Off.

Select Log On to re-enable SSIS Analysis and Charting options.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
Analysis and Charting Page 17 of 60



SSIS Training

SSIS Analysis and Charting Log On

SSIS Analysis Log On 5.2.2 3]

1a SSIS
dl L oo

Thiz 5515 Analpsiz software uges Sacial Services
Information System data. Data contained in the Social
Services Information System [S515] iz private and/or
confidential data about individuals. Access is limited to
the minimum extent required to perfarm paur job duties

D ata may only be shared with the client's signature,
certain court orders, o in the contest of other legally
authorized situations. Contact your Supervisor, Data
Practices Responsible Autharity, or County Attarney if yau
have any questions. Inappropriate access, disclosure, of
other uge of 5515 data may result in disciplinary action
including dismizzal and/or criminal charges where warranted.

Uszer ID LISA
Password ]
Database  |S5IS_DATA -

Cancel

Logging on to SSIS Analysis requires reentry of the User ID and Password.

To Log back on to SSIS Analysis and Charting:

Select File menu.

Select Log On.

The User ID field defaults to the worker’s user ID.

Enter worker’s regular county/tribe workstation password in the
Password field.

The Database field defaults appropriately to SSIS_DATA.

Click OK.

o v .»P.oo.NHQU

Options - Chart and Color Changes

Workers access Chart Options and Data Colors to view their Federal and State
Indicator Charts by selecting Options from the File menu.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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Analysis and Charting Options

Help

Log OFf

Dpkions

Exxit

To View options:

&

1. Select File menu.
2. Select Options.

Options - Chart Options Tab

¥ Analysis and Charting Options
Chart Options l Data E.:I.:.rs]

v Show values
v Show legend
[ Show 3D

k. Cancel

Social Services Information System (SSIS) Version 5.2 D
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Two tabs display:
e Chart Options
e Data Colors.

The Chart Options tab is the default tab. Data values, legend and 3D are
available for display on charts.

e To have data values display, check Show values.

e To have the data value legend display, check Show legend.

e Check 3D to change the view of charting display.

To begin setting up a customized visual component of SSIS Analysis and
Charting:

1. Check Show values.
2. Check Show legend.
3. Click OK.

The Data Colors tab is the second tab available in the Options menu. A large
number of color options are available in the Data Colors grid for selection.

Color options can be changed for naming columns of data and for the numeric
data indicators on pie-charts, columns, etc.

The color options for data are to accommodate users with color-impaired vision.

Color options can also be changed to present chart data in other formats, e.g.,
copied into Microsoft PowerPoint presentations.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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Data Colors Tab

# Analysis and Charting Dptions _ ||:||i|
Chart Options  Data Colors |

Drag and drop a color onto a data label,

data 1
data 2
data 3
data 4
datab
data 6
data 7
data 8

data 10

. Reset |

] ceres |

To set up a customized color visual component of SSIS Analysis and Charting:

&

1. Select File menu.
2. Select Options.
3. Select Data Colors tab.

The listing of data 1-12 gives the SSIS default color choices that are applied to
charts. One or all of these data columns can have the data color changed.

SSIS initially defaults the color choices of data 1 through data 12 as shown.

Social Services Information System (SSIS) Version 5.2 D
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Column Colors

data 2
data 3
data 4
data b
data 6
data 7
data 8

data 10

Once a worker customizes these color choices, the new colors display until the
worker changes color choices. The Reset button can be selected to revert back to
the SSIS default colors.

As indicated on the tab, click on and drag and drop a color onto the data label to
be changed. A small, white block displays when the color on the grid is selected.

Color Section

The small, white block remains until a data column is selected and you release
the mouse.

¢

Data Column Available for Color Change

data 2%

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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To add colors to the data column:

Y
1. Click, drag and drop a color from the data color grid to data 1 column.
2. View selected color.

Data - Color Changed

data 1
data 2

The Marks field indicates where specific numbers or data display alongside a bar
or pie chart. The numerical values on a column or pie chart can have different
colors. The SSIS default color is beige.

Marks - Default

To change the Marks field background color:

—
<
1. Click, drag, and drop a color from the data color grid to the Marks field.
2. View selected color.

Marks - Color Changed

QBest Practice: If copying charts or using charts for presentations, review Data and
Marks color choices for easy readability.

Color selections can be reset.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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Reset

Heszet

To restore SSIS data color default choices:

@ Click the Reset button.

The Cancel button can be used when color changes are not necessary. Clicking
the Cancel button will return the user to the previous screen viewed.

Cancel

Cancel

To cancel color changes:

—D
@ Click Cancel.

Color changes can also be saved.

To save changes to color changes:

Y Click OK.

Tools Menu

The second menu option on application toolbar is the Tools menu. The Tools
menu allows the work to easily access one of the other SSIS applications. The
other applications include: SSIS Administration, SSIS Repository, and SSIS
Worker.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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Tools Menu
=8 Help

7 2515 Administration

. E

Sh: 5515 Repository

@E S5IS Worker

To access another SSIS application from SSIS Analysis and Charting:

S
1. Select the Tools menu.
2. Select the desired application.

Workers must have security to access the application selected.

Help Menu

The third menu option on application toolbar is the Help menu.

Help

Bl

About, ..

To access the Help feature:

&
1. Select the Help menu.
2. Select About...
3. The About SSIS Analysis and Charting screen displays.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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About SSIS Analysis and Charting

About 5515 Analysis and Charkting x|

TR FEEEELE Y

- —————
= e -

Minnesata Department of Human Services

Immediately viewable is the version of SSIS Analysis and Charting used by the
worker. In this instance, the Help menu and About feature are standard
Windows features that do not contain any Help features.

5Click OK button to return to previous page.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
Analysis and Charting Page 26 of 60



SSIS Training

SSIS Analysis and Charting Outcome Indicator Features

SSIS Analysis and Charting contains many features to assist the user in accessing
and viewing information. These features are available when looking at Federal
and State indicators.

Accessing Indicator Definitions

Federal Round 1, Federal Round 2, and State Outcome Indicators each have their
own associated measures. Each measure has an associated definition for ease of
selection.

To review the definition of each measure, move the cursor over the measures
until one is highlighted in blue and the cursor forms a small hand.

Data Analysis Menu

Homme

Federal
indicators
round 1

Federal
indicators

Highlight Measure For Definition

Permanency outcomes
Child Weliare Outcome 3: Increase Permanency for Children in Foster Care
Measure 3.2 Measure 3.3
=
Measura 3.4 Measura 35
Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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To access a specific measure definition:

—_

Select Federal indicators round 1, Federal indicator round 2, or State
indicator from the Data Analysis menu.

2. Move cursor over a measure.

3. Note the change in Indicator definitions.

Indicator Definition

Fed 3.1: For all children wha exited the child welfare system, what percentage left ether to reunification, adaption, legal guardianship, permanent transfer of legal and physical custady to a relative, or reached age of majority or
emancipation’

Viewing a Specific Indicator

Measures are accessed by first accessing the outcome indicator, then selecting a
specific measure.

To access a specific indicator:

&
1. Select Federal indicators round 1, Federal indicator round 2, or State
indicator from the SSIS Analysis and Charting menu.
2. Select desired measure.
3. The page displays the county data available for the measure chosen in the

most appropriate charting format, e.g., pie graph, bar graph, or line graph.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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Outcome Indicator Charting Screen

¥ 5515 Analysis and Charting 5.5.0.111

File Tools Help

Line Bar Pie | Walues Legend 203D | Copy Pint | Datz | Feport | Refiesh

Home From: [01/01/2007 | To:[09/15/2009 ~| Categary: | Filter| |
Fed 1.1: OF all children who were victims of substantiated or indicated child abuse and/or neglect during the
Federal reporting period, what percentage had anather substantiated or indicated repart within a ik month period?
indicators
round 1 Recurrence of Child Abuse and heglect (Federal Measure 1.1) Frequency Percentage
Federal gu Recuirence 2; 9:;
i ECumence 3
indicators [ Recurrence 59 %
round 2 I Mo Recurrence 931 %
Tatal 29 0%
State
indicators
SSIS
ili=ls]
Charts

The SSIS Analysis and Charting page contains the following seven sections:
e Indicator Title

e SSIS Analysis and Charting Menu

e The Outcomes Toolbar

e Indicator Description

e Main Chart Working Area

e The Frequency or Contingency Table

e Notes Section.

Indicator Title

For the Federal Indicators, the title reflects whether you are viewing a Child
Safety Outcome Indicator or a Child Permanency Outcome Indicator.

Indicator Title

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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For the State Indicators, the title reflects whether you are viewing a Child Safety
or Child Permanency outcomes indicator or a Welfare System Activity Indicator.

OHint: The SSIS Analysis and Charting Menu continues to display.

Indicator Description

Use the indicator description as a reminder of which Federal or State outcome
indicator you are viewing, and the definition of that indicator.

Indicator Description

Fed 1.1; Of all children who were wictims of substantiated or indicated child abuze and/or neglect during the
reparting period, what percentage had another zubstantiated or indicated report within a zis month penod?

Main Chart Working Area

The Main Chart Working Area displays the type of chart you are using to view
data, the color options selected, display marks for data numeric values, and the
legend available.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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Main Chart Working Area

Increase Placement Stakility

24 to 35

1210 23

Oto12

36 to 47 438 ar

Bs0to12

W4z 121023
W 20 24 to 35
W 55 36 to 47
B 0 45 or mare

mare

The Frequency or Contingency Table

The Frequency or Contingency Table gives the total number of children

represented in the chart and the percentages of these children that correspond
with category and filter selections made on the Outcomes toolbar.

The Frequency or Contingency Table

|Category | Court | Percert... ||

Oto12 ] 100
12t0 23 45 100
24 to 35 20 100
36 to 47 3] 100
48 or more 0 0

|T|:|tal

= |
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Notes Section

Depending on the Federal or State indicator, a Notes Sections may display.

The Notes Section provides:

e Definitions of terms

e Explanation of data

e Additional supportive information.

Notes Section

Sumnmary data 1z categonzed by monthe-in-care
rahges.

The total percent can exceed 100 i children
records are included in multiple categon values.

Outcomes Toolbar

The Outcomes Toolbar contains charting options and data filters to produce
specific charts and to view the raw data.

Outcomes Toolbar

Line Bar Pie | Walues Legend 20/30 | Copy Pint | Data | Bepot | Refresh

Fiom [01/01/2007 w| T [06/A2007 =] Category: | Type of dbuse/Negl = | Fier [N ~ || C-Adul Mental Health Services

C-Adult Services
Fed 1.1 0F al children who were victims of substantiated of indicated child abuse and/or neglect during the [-Chemical Dependency Services
repotting period, what percentage had another substantiated or indicated report within a giv manth periad? [-Child Mental Health Services
C-Child Protection Services

Outcomes Toolbar
Line Bar Pie ‘ Yales Legend 20/30 I Copy Pt IData ‘ Repiort I Refiesh
me:lWZ[IIJS j To:lEJSDf’ZI]DS j Eategory:lﬁace j Filler:l j

Click the Line option to change the charting type to a line graph. The legend,
marks, and line colors can be adjusted by selecting File>Options.
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Line

Line

To view Line graph:

<
1. Select Line.
2. Review line chart type.

Click the Bar option to change the charting type to a bar graph.

Bar

Ear

To view Bar graph:

&

1. Select Bar.
2. Review bar chart type.

Click the Pie option to change the charting type back to a pie chart.

To view Pie chart:

)
@ Select Pie.

Social Services Information System (SSIS) Version 5.2 D FINAL 12/1/09
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OHint: It is possible that SSIS Analysis and Charting does not offer a Line, Bar or
Pie chart based on the system’s ability to display the information in that format, e.g., the
data visual model would be too complicated.

Click Values to enable or disable values indicators on the chart.

Values

W ales

To view Values:

1. Select Values.
2. Note that numerical values display or are disabled.

Click Legend to enable or disable the legend on a chart.

Legend
Legend

To view Legend:

S
1. Select Legend.
2. Note that legend displays or is disabled.

The 2D feature displays a basic chart without shadows.

2D

20450
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To view in 2D:

@ Click 2D to view chart.

When creating a Microsoft PowerPoint slide of charts, select the 3D Option for a
more distinct appearance.

To view in 3D:
<
1. Click 3D.
2. Note display difference on chart.
Use Copy to copy and paste the chart into a document, report, Microsoft

PowerPoint, or e-mail message.

Copy

Lopy

OHint: When the Copy link is selected, a copy of the main chart area only is taken.
Paste directly into the selected format for presentation or writing purposes.

To print a chart to your workstation’s printer, select Print. Only the chart and
descriptive area print. This is called the chart working area. A dialog box
displays to allow the worker to select which printer to print to in their
county/tribal office.

Print

Fririt

Select Cancel to cancel printing option.
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The client data that is the basis of the Federal or State indicator is available to
view by selecting Data.

Data

[iata

To view client data for a particular Federal or State indicator:
Y Select Data to view to the actual client information which is the basis for
SSIS Analysis and Charting.

The client data displays based on the Federal indicator selected, the date range,
the category selected and any filter selected.

.
Client Data
Chat | Heport | Refresh
From: [01/01/2007  =| To:[06/30/2007  +| Categon: [Type of Abuse/Negl v Fiter: [Urit -] E sddtftltSMental Health Services
-Adult Services
Fed 1.1: Of all children whao were victims of substantiated or indicated child abuse and/or neglect during the C-Chemical Dependency Services
reporting period, what percentage had another substantiated or indicated report within a six month period? C-Child Mental Health Services
C-Child Protection Services
|F'erson Il | Child - |Ger - |Hace - || Initial Dispositian [ Initial Type ~ |[Subzequent Dizposzition
101995211 | Ambay, Anna Female | Am Indian 041642007 physical abuse 054012007
101935213 | Amboy, Andrew JF Male | Am Indian, Caucasian 04/16/2007 physical abuse 05/01/2007

Information contained in the grid changes based on the above criteria.

To view, print, or export a report that includes the main charting area, the
frequency or contingency table, and the raw client data, workers select Report.

Report
Report
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To view a Report:

Select Report.

The Report displays in a Print Preview.

Report Print Preview

R Print Preview

S BEE Bx W« o

Recurrence of Child Sbuse and Meglect [Federal Measure 1.1)
Period: 010172007 to 063002007

S‘ﬂ}ﬁg‘g rﬁ mﬁw am Fa%:ljgrdcﬂﬂjdﬁldd:wea’d.tlraja:tdlirgﬂ“elﬂ:ﬂﬁrgﬂaioiﬂ‘dpﬂca’ta;}‘ajarﬁﬂ

Fraquaney  Pareant
RechrE i 2 G%

Ho Fecargacs a1 5.0%
Totl et 100.0%

@

Parien |0 Child Neme Gander DOBE Race nital I:Ilpnllhnn ind Cate Euuluqunnt I:Ilpnllhnn gnd Cate Boclal Warkar
1gasa)] Smboy, Arna - e Y: g onny  Rebecca Lalsy
01955219 Amboy, Ardrew JR Mak Dmmt -'"‘" hdlﬂ" DI\S tEIaJlse nms.m Dhﬁbalzbl(e nenion0T Rebecca Lalsy

1027005 830112 AR

IF‘age 1of1

by

The Report displays:

e The selected chart type

e The Contingency or Frequency table

e The raw client data entered for a selected outcome indicator.
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To return to Outcome Indicator charting page:

@Click Close.

Use the Refresh button when dates, categories, or filters are changed when
working with a particular chart.

Refresh

Hefresh

To reflect data changes based on filter options:

DY Select Refresh.

Each indicator defaults to a six-month or one-year date range using the Federal
reporting periods for the selected indicator. This can be altered by using the date
picker to select a date range by month, quarter, semi-annually, annually, etc.

From Date

From: |01/01/2007

To select a report start date:

@Selec’c the From: field drop-down and use the date picker to select a date.

When the From: date is changed, the To: date automatically readjusts to the
default six-month or one-year period.

To Date
To [OBSI0/2007 -
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To select a report end date:

<
1. Select the To: field drop-down and use the date picker to select a date.
2. Select Refresh to view refresh data on charting page.

The Category field drop-down may contain options to narrow the data
displayed.

Category

Categony: j

hiated ar in
stantiated

Gender
Face
Tvpe of Abuse/MNeglect

To select a category:

—
<
1. Select the Category field drop-down to view options.
2. Select a category.

Filter
Filter: | Unit -

“regl
."-iU ™

Some indicators have additional filters based on the category selected.

To use a filter:

—
S
1. Select the Filter field drop-down.
2. Select an option if available.
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Specific Filter Options

(- Ak Menkal Healh Seices A
C:Adul Senices
(:ChemicalDependency Senvings

 CChid lental Heath Services

4 Child Fioeci

Once a Filter option is chosen, data can further be narrowed.

To select a specific filter:

1. Select one or more options by clicking in the check boxes.
2. Select Refresh to view refresh data on charting page.

The Main Chart Working area includes:

e Name and Number of Federal measure
e The chart type selected

e The values display if selected

e The legend displays if selected.
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Main Charting Area

Permanency for Children Exiting System, By Race
Federal Measure 3.4

B 20 Am Indian
Il 0 Asian

Il 10 Black/Af Am
[l 20 Caucasian
[ 40 Not Det

Il 10 Pac s

@Policy: The CFSR previously defined process and Federal audit incorporates
assessment of these outcome indicators.

| \

\ /

@ Job Aid: Refer to the CFSR Safety, Permanency and Well-Being job aid available
on the SSIS website.

Enhanced Grid Features

Additionally, workers customize reports by using Enhanced Grid features to
display client data. Enhanced Grid features included in SSIS Analysis and
Charting are:

e Show Group Columns

e Auto Filter

e Move Columns

e Export Grid to:
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- HTML (Internet Explorer)
- Microsoft Excel

- Text (Comma delimited)
- XML.

Enhanced Grid Feature — Show Group Columns

Fed 1.1 Ot all childhen wha were victims of substantiated or indicated child abuse and/or neglect during the
reporting peniod, what percentage had anather substantiated or indicated report within a six manth penad?

dH[ here o oy lrlp y thiat cohmn

C h||d ﬁg] Inllial Dispostion

bR froboy, &nna | Female | dm Indian 041652007

101335213 Amboy, Andrew JF Male | Am Indian, Caucasian 041672007

Enhanced Grid Feature — Autofilter

[Criztom.... ]
101395211
101395219

Enhanced Grid Feature - Move Columns

UTEE] & column header here to graup by Thqf i I]umn

Initial Disposiion . Iniial D

QEEEANY Amboy, Anna Female 04
101335213 Ambay, Andrew JF | Male |U4a’1 B/2007

Export Grid
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.
Export Grid
Save As @@
Savein: ‘ <@ D085-00-1413660c [C:) j e BE-
2. ICDHS
3 @Documents and Settings
My Recent ISetc
Documents 50 Filehiat
@ @Lntus
M3OCache
Desktop I aldmachine_lacal_files
. IS Frogram Files
7 IC2)QETIMER
My D 3 RECYCLER
4 Lacuments System Yolume Infarmation
- 120 Tivali
nil WINDOWS
DHS Computer
D023-00-1413...
Network, File narme: |GricLE wpart j Save
Save as type: |HTML [Internet Explarer) j Cancel

Microzsoft Excel
Text [Comma delimited)

HML

OHint: Enhanced Grid features operate the same as in SSIS Worker/Fiscal.

.
by
~— Handout: Refer to Enhanced Grid CBT.

http.//www.dhs.state.mn.us/main/idcplg?IdcService=GET DYNAMIC CONVERSION

&RevisionSelectionMethod=LatestReleased&dDocName=id 000453
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Data Analysis Menu

The Data Analysis Menu on the left side of the page contains links to:
e Home

e Federal indicators round 1

e Federal indicators round 2

e State indicators

e SSIS Web Charts.

Data Analysis Menu
Horme
Federal

indicators
round 1

Federal
indicatars

indicators

5515
Weh
Chars

SSIS Analysis and Charting contains county- and tribe-specific data that reflects
Federal and State indicators for outcome reporting. To view county-specific
information, workers select either Federal indicators round 1, Federal indicators
round 2 or State indicators.

Main Home Page

Workers may click Home anywhere in the application to return to the main
home page.
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Home

Horme

To return to the main home page:

)
@ Click Home.

Federal Indicators Round 1

SSIS maintains the Federal indictors round 1 data for county use. The outcome
indicators reported currently are those displayed in Federal indicators round 2.

Federal Indicators Round 1

Federal
Indicators
round 1

To view the original SSIS Federal outcome indicators, click the Federal indicators
round 1 link.

To view Federal Indicators round 1:

—
@ Click Federal indicators round 1 link.

@
AN
/ \\
|
\

S Job Aid: Refer to Federal Indicators Round 1 job aid located on the SSIS website.
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Federal Outcome Indicators Round 1

¥ SSIS Analysis and Charting 5.5.0.111

File Tools Help

Fed 1.1: Of all childien who were victims of substantiated or indicated child abuze and/'or neglect during the reporting period, what percentage had another substantiated or indicated repart within a six

month period?

Home
Safety outcomes

Federal
indicators
round 1
Federal
Indicators Measure 2.1
round & Permanency outcomes
State Child Welfare Outcome 3: Increase Permanency far Children in Foster Care
indicators teasure 3.1 Measure 3 2 Measure 3.3
8IS Measure 3.4 Measure 35
Wah } o o :
Chars Child Welfare Outcome 4: Reduce Time in Foster Care to Reunification Without Increasing Re-entry

Measure 4.1 Measure 4.2

Child Welfare Outcome 5 Reduce Time in Foster Care to Adoption

Measure 5.1 Measure 5.2

Child "Welfare Dutcorme 6 Increase Placement Stability
Measure 6.1

Child YWelfare Outcome 7: Rieduce Placements of Young Children in Group Homes or Institutions
Measure 7.1

The Federal Outcome Indicators Round 1 page provides links to the Safety and
Permanency Measures data culled from the agency database.

There are two Safety outcomes with one measure each. These are:
e Measure 1.1

e Measure 2.1.

Safety Outcomes

Safety outcomes

Child Wweltare Cutcome 1: Reduce Recurrence of Child Abuse andfor MNeglect

I e

Child Wweltare Cutcome 2: Reduce the Incidence of Child Abuse andjor Meglectin Foster Care
hMeasure 2.1

There are five Permanency outcomes. Permanency outcomes have 11 measures:
e Measure 3.1

e Measure 3.2
e Measure 3.3
e Measure 3.4
e Measure 3.5
e Measure 4.1
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e Measure 4.2
e Measure 5.1
e Measure 5.2
e Measure 6.1
e Measure7.1.

Permanency Outcomes

Permanency outcomes
Child Welfare Outcome 3: Increase Fermanency for Children in Foster Care

hMeasure 3.1 kMeasure 3.2 kMeasure 3.3
hMeasure 3.4 kMeasure 3.5

Child \Welfare Outcome 4: Feduce Time in Foster Care to Feunification Without Increasing Fe-entry

kMeasure 4.1 kMeasure 4.2

Child Welfare Outcome 5: Reduce Time in Foster Care to Adoption
beasure 5.1 beasure 5.2

Child Welfare Outcome B: Increase Flacement Stability
teasure £.1

Child Welfare Outcome 7: Reduce Flacements of %'oung Children in Group Homes or Institutions
teasure 7.1

Federal Indicators Round 2 - Currently Reported

The 2007 Federal Composite Indicators are available by clicking the Federal
indicators round 2 link.

Federal Indicators Round 2

Federal
indicators
round &

To access Round 2 indicators:

-
Y Select Federal indicators round 2 on the SSIS Analysis and Charting Menu.
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Federal Outcome Indicators Round 2

¥ S5IS Analysis and Charting 5.5.0.111

File Tools Help

Fed 1.1: OF all children wha were victims of substantiated or indicated child abuse and/or neglect during the reparting period. what percentage had anaother substantiated or indicated report within a six
month perod?
Home
Safety Indicators

Federal .
indicatars Safety Indicatar 1: Absence of Maltreatment Fecurrence
round 1 } FT1
Federal Safety Indicator 2: Absence of Child Abuse or Meglect in Foster Care
indicators Measure A2
round 2 Permanency outcomes
State Permanency Composite 1: Timeliness and Perrmanency of Reunification
ik diaiars Messure C1.1 & C1.2 Measure C1.3 Meagure C1.4
SSIS Permanency Composite 2 Timeliness of Adoptions
el Measure C21 & C22  Measure C2.3 Meagure C2.4
Charts

Meagure C2.5

Permanency Composite 3: Achieving Permanency for Children in Foster Care
Meagure C3.1 Measure C3.2 Measure C3.3
Permanency Composite 4: Flacement Stakbility
Measure C4.1 Measure C4.2 Measure 4.3

- /]ob Aid: Refer to Federal indicators round 2 job aid available on the SSIS website.

Federal indicators round 2 measures include Federal Safety Indicators and
Permanency outcomes.

The Safety Indicators include:
1. Safety Indicator 1: Absence of Maltreatment Recurrence (note this is the
inverse of federal measure 1.1) Measure RT1
2. Safety Indicator 2: Absence of Child Abuse or Neglect in Foster Care (note
this measure is the inverse of federal measure 2.1) Measure RT2.

OHint: RT1 equals Round Two 1 and RT2 equals Round Two 2.

The new Federal Permanency Outcomes are all composite measures. The actual
composite is a score we receive from the Children’s Bureau which is made up of
the measures of each composite. SSIS is producing the individual measures for
each individual agency; SSIS is not attempting to create the total composite score
because agency numbers do not necessarily fit the Federal equation.
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1. Permanency Composite 1: Timeliness and Permanency of Reunification,
which is a composite of the following four measures: Measure C1.1. &
C1.2, Measure C1.3, and Measure C1.4.

2. Permanency Composite 2: Timeliness of Adoptions, which is a composite
of the following five measures: Measure C2.1 & C2.2, Measure C2.3,
Measure C2.4, and Measure C2.5.

3. Permanency Composite 3: Achieving Permanency for Children in Foster
care, which is a composite of the following three measures: Measure C3.1,
Measure C3.2, and Measure C3.3.

4. Permanency Composite 4: Placement Stability, which is a composite of
the following three measures: Measure C4.1, Measure C4.2, and Measure
C4.3.

OHint: SSIS extracts Federal round 2 indicators directly from the individual
county/tribe servers and the individual county/tribe data. DHS Research & Planning
uses a different tool and extracts data from the DHS Data Warehouse for Federal round 2
indicators. The Federal Children’s Bureau receives the data for the Federal round 2
indicators from AFCARS and applies its own tool to determine composite scores.

The data from all three sources should show similar trends, but not exact numbers. In
creating Program Improvement Plans (PIP), counties/tribes should use SSIS Analysis
and Charting for the most recent data relevant to their individual agency.

Federal indicators round 2 contain the same types of visual components, search
filters, and raw data as Federal indicators round 1. The difference in data lies in
how the data is determined and interpreted.

For example, moving the cursor over each of the Permanency Composite 1
measures changes the Federal description of what outcome is being described.
The measures capture a different view of the child permanency indicator data.

Measure C1.1. & C1.2 displays: Of all children discharged from foster care to
reunification in the year shown, who had been in foster care for eight days or
longer, what percent was reunified in fewer than 12 months from the date of the
latest removal from home? (Includes trial home visit adjustment.) Median
months to reunification (measure C1.2) =4.4.
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Measure C1.3 displays: Of all children entering foster care for the first time in the
six-month period just prior to the year shown, and who remained in foster care
for eight days or longer, what percent was discharged from foster care to
reunification in fewer than 12 months from the date of the latest removal from
home?

Measure C1.4 displays: Of all children discharged from foster care to
reunification in the 12-month period prior to the year shown, what percent
reentered foster care in fewer than 12 months from the date of discharge?

To view one of the new federal measures, workers click on one of the
Permanency outcomes.

To view a federal Permanency measure:

)

CJ " Select a measure under the Permanency outcomes section.

OHint: Measure C1.2 is a single value and thus not conducive to charting.
This measure is calculated and displayed on the screen for chart C1.1.

\@/]ob Aid: Refer to the Outcome Indicator Data Descriptions job aid available on
the SSIS website.
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State Indicators

The Minnesota CFSR uses outcome data from the State indicators to assess
county/tribal social services agency performance.

State Indicators

State
indicators

To view State outcome indicators:

—
CJ Select the State indicators on the SSIS Analysis and Charting menu.

The State indicators link displays the following Safety outcomes, Permanency
outcomes, and Welfare System Activity Indicators.

—
\ )
\\

~— Job Aid: Refer to the State Indicators job aid available on the SSIS website.

State Outcome Indicators

¥ S51S Analysis and Charting 5.5.0.111

File Tools Help

tAM1: OF all children wha were victimes of substantiated child abuse and/or neglect during the reporting period, what percentage alzo had a substantiated allegation in the previous twekve months?
Home
_—_— Safety outcomes
ederal
indicators 2 M7
round 1 Permanency outcomes
Federal M3 M4
indicatars
round 2 G MG
State
indicatars Welfare System Activity Indicators
SS131 SEI52 SEIS3
SSIS
‘Web 55154 55155 jaisiiiiy
Charts
SSIS7 SEISE SS9
SSIS10 SSI511 S51512
SSI513
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The Safety outcomes are:
e MNI1
e MN2
e MN7.

The Permanency outcomes are:
e MN3
e MN4
e MN5S
e MNE6.

The Welfare System Activity Indicators are:
e SSIS1
e SSIS2
e SSIS3
e SSIS4
e SSIS5
e SSIS6
e SGOIS7
e SSIS8
e SSIS9
e SSIS10
e SGOIS11
e SSIS12
e SGIS13.

To view a State Indicator:

—D
@ Click one of the State Indicators.
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State Indicators Charting Page

Line Bar Pie | Yalues Legend 20/30 | Copy Print | Dats | Beport | Refresh
Home From: [01/01/2007 =] To| | Cotegeny | Fiter =
MNE: Far all children who had a termination of parental rights of any living parent at angtime during the vear, what
Federal percentage experienced finalized adoption, declined adoption, or sither reached age of majority or were
indicators emancipated?
round 1 State Ward Outcomes (State Measure M) Categary Frequency Percentage
Federal Adopleq ] 211
indicatars Age Maj./Eman. ] ]
round 2 O Acopted 211 % | Declined 0 0
[ Age MajEman. 0 % || Other 30 789
State Il Declined 0 %
i Il Cther 759 %
indicators Total 3 100%
SEI1E
i=l)
Charts
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SSIS Web Charts

County or tribal workers may compare individual county outcome indicators
with those reported by the State for all counties and two tribes twice yearly.

SSIS Web Charts

S5
Wiekb
Charts

To view the Statewide reported outcome data:

)
@ Select SSIS Web Charts.

SSIS Web Charts provides a direct link to the DHS>CountyLink>5SSIS>Outcome
Charting web page.

SSIS CountyLink Site

Skip to: Main content | Subnavigation |

i,
ount f ljj, Tuesday, September 15, 2009
| ! | Minnesota Department of Human Services i n i i north;ta?’r

deod K

Fiscal Reporing & Accounting | Manuals | Falicy Inquiries | Iraiank|

CountyLink Hom

County Reports/Results | DHS Program Resources B

MHN-ITS = DHS Systems and IT Updates = 5515 resources = Outcome Chartin
MAXIS resources
MEC* resources Outcome Charting

MMIS resources 58515's Analysis and Charting software 100l helps county social workers, supervisors and managers:

PRISM resources
= Wiew 3515 datain chars

SIR

sml = Analyze that data

SSIS resources = Assess agency services outcomes to children and families

\ Fiscal = Assess activity within the child welfare system

v Fiscal Mentor Prograrm Click onthe links below to access charts produced from data in the State Repository during the most recent reporting periods. Compare

\ Viorker Mentor Piogram statewide data with specific county outcomes.

» Qutcome Chartin Federal Outcame Indicators — Round 1

+ Federal Indicators

» State Indicators Federal Outcorne Indicators — Round 2
+ Publications
v Support State Outcome Indicators
v SO Sl
+ Training

@2009 Minnesats Department of Human Services Online Updated: 2409 11:09 AM | Accessibilty | TermsPolicy | Contact DHS | Top of Page |
Maorth Star is led by the Office of Enterprise Technology
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SSIS posts the current national standards for each Federal Indicator. These
screens are updated in April and November of each year.

Counties and tribes can use this link to compare their county/tribal data to the
statewide data submitted to the federal government.

Select one of the Federal Outcome Indicators links on the Outcome Charting

page to review the current and previous Federal review period for each Outcome
indicator.

Federal Outcome Indicators Link on Website

Federal Qutcame ndicators — Bound 1

Federal Qutcame Indicators — Bound 2

To view statewide outcomes reported to the Federal government:

@Select the Federal Outcome Indicators — Round 1 or Federal Outcome
Indicators — Round 2 link.
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Federal Outcome Indicators Current and Previous Reporting Period
Federal Outcome Indicators — Round 1

The twao most recent reparting periods are captured helow each Indicator description.
This page was updated on 5r20/09.

Child Welfare Qutcome 1: Reduce Recurrence of Child Abuse andfor Meglect
Federal Measure 1.1

Fed1.1: Of all children who were victims of substantiated ar indicated child ahuse andfar neglect during the
reporting period, what percentage had another substantiated or indicated report within a six month period?

104108 - 353109 Recurrence of Child Abuse and Meglect (Feceral Messure1.1)

[E] Recurrence 36 %
I Mo Fecurrence 954 %

47108 — 943008

tecurrence of Chid Abuze and Hegect (Federal Measure 1.1)

TRecurrance 421 %

Il Mo Recurrzncs 9575 %
4 4%
To view additional Federal outcome indicators:
Y Scroll through the current Federal outcome indicators.
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To return to the Outcome Charting website from the Federal Outcome
Indicators:

CYJ Click the Back arrow on your internet browser.

Select State Outcome Indicators links on the Outcome Charting page to review
the current and previous State review period for each Outcome indicator.

State Outcome Indicators Link

State Outcome Indicatars

To view State outcomes Indicators:

@ Select the State Outcome Indicators link.

State Outcome Indicators

State Outcome Indicators

The two most recent reporing periods are captured below each Indicator description.
This page was updated on 5522509,

Safety Outcome: State Measure Mi 1

M Of all children who were victims of substantiated child abhuse andfor neglect during the repaoring
period, what percentage had another substantiated report within a twelve month period?

41 I108— 3/30/08 ultiple Abuse Reports in e 12-Month Period (State Measure M)

OrRecarrence 43% |
B Mo Recurrence 957 %)

[s57e]
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To view additional State Outcome Indicators:

&Scroll through the current State outcome indicators.

To return to the Outcome Charting website from the State Outcome Indicators:

—

Y Click the Back arrow on your internet browser.

Other SSIS resources and job aids referenced in this module are located on the
SSIS website. The SSIS website is accessible from the Outcome Charting page.
The SSIS resources link is located in the left column. Click on the desired option
to access resources.

CountyLink - SSIS Menu
S5ISresources

v Fiscal

v Fiscal Mentor Prograrm

v orker Mentor Program
v Dutcame Charting
v Federal Indicatars

v State Indicators

v+ Publications

v Support
v SWWNDE T Shl

v Training

To access SSIS resources:

—
Y Click on the desired option on the SSIS menu.

When CountyLink is no longer needed, close the screen and return to SSIS
Analysis and Charting.
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Close Internet Window Button

X
To return to SSIS Analysis and Charting from CountyLink:

—
@ Select the Windows close button.
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Resources:

e Some Requirements of the Adoption and Safe Families Act of 1997

e AFCARS - SSIS Repository Cross Reference — October, 2007
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET FILE&RevisionSel
ectionMethod=LatestReleased&Rendition=Primary&allowInterrupt=1&noSav
eAs=1&dDocName=dhs id 051983

e CFSR Safety, Permanency and Well-Being chart
http://www.dhs.state.mn.us/main/groups/county access/documents/pub/dhs

id 048651.pdf

e Charting Features

e Federal Indicators Overview Round 1

e Federal Indicators Overview Round 2

e State Overview Indicators

e Outcome Indicator Data Descriptions.
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